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User Guide 1


User Guide
OpenKM is a tool to manage documents generated within a company, to improve access within the whole corporate
environment and to endeavor to keep in check the unnecessary duplication of information.
OpenKM provides the solution to:
•• Control the growing volume of information to be managed
•• End the diversification of information storage sources
•• Prevent the duplication of information
•• Obtain valid information through the control of document versions
•• Reduce time and resources used in locating information
•• Avoid knowledge leaks or wrongful access by users, thereby complying with the obligations set out in the LOPD


(Spanish Data Protection Law)
•• Restrict non-authorized users access to the information.
Through the OpenKM system, relevant and useful information can be accessed and found in the least possible time
to resolve problems and make decisions.
OpenKM helps to improve corporation processes, integrating common tasks (and interrelated tasks) into one single
tool and permitting the different departments of the organization controlled and supervised parametrizable access to
the information.
•• System access
•• User interface


•• Desktop screen
•• Menu bar
•• Toolbar
•• User identification
•• Status bar
•• Workspace
•• Path
• Taxonomy (folder tree)
•• Document browser
•• Properties panel


•• Basic operations with documents and folders
•• Create folder
•• Find folder
•• Find document
•• Find similar documents
•• Inserting documents
•• Wizard
•• Renaming
•• Move
•• Copy
•• Adding bookmark
•• Set home
•• Deleting
•• Keyword shortcuts
•• Uploading from desktop computer



http://wiki.openkm.com/index.php?title=Find_document

http://wiki.openkm.com/index.php?title=Find_similar_documents
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•• Application splitters resize
•• Specific operations with documents


• Document edit (check-out)
• Cancel edit (cancel check-out)
• Update a file (check-in)
•• Lock
•• Unlock
•• Downloading a document
• Adding a metadata to a document (property group)
• Deleting a metadata from a document (property group)
•• Adding keywords
•• Adding categories
•• Copy to clipboard
•• Send document as attachment


•• Massive operations with several documents, folders and mails
•• Fast select and unselect
•• Massive delete
•• Massive move
•• Massive copy
•• Massive add note
•• Massive add category
•• Massive add keyword
•• Massive property group


•• Extra columns
•• Pagination
•• Categories
•• Metadata view
•• Thesaurus view
•• My documents
•• Templates
•• E-mail
•• Trash
•• Using information
•• Security
•• Search


•• Fast search
•• Making a search
•• Executing a stored query
•• Deleting a stored query
•• Opening the location of a document
•• Opening the location of a folder
•• Save as a user news
•• Searching with OpenKM


•• Dashboard
•• Notification service
•• Subscription service
•• Starting a Workflow



http://wiki.openkm.com/index.php?title=Fast_search

http://wiki.openkm.com/index.php?title=Making_a_search

http://wiki.openkm.com/index.php?title=Executing_a_stored_query

http://wiki.openkm.com/index.php?title=Deleting_a_stored_query

http://wiki.openkm.com/index.php?title=Opening_the_location_of_a_document

http://wiki.openkm.com/index.php?title=Opening_the_location_of_a_folder

http://wiki.openkm.com/index.php?title=Save_as_a_user_news

http://wiki.openkm.com/index.php?title=Searching_with_OpenKM
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•• Workflow pending task
•• User configuration
•• System tools


•• Languages
•• Appearance


•• Using iPhone or Android
•• Help
•• Microsoft Office Addin


•• Outlook addin
•• Word Addin
•• Excel Addin
•• PowerPoint Addin


•• OpenOffice.org Add-on
•• Community extension


•• Macros
•• Downloading restricted buttons


•• Professional extensions
•• Stapling
•• Autocad preview
•• Messaging
• Stamp Image or Text Watermark
•• Digital signature
•• Cryptography
•• Contacts
•• Activity log tab
•• Google contacts synchronization
•• Forum
•• Wiki
•• Zoho
•• Google docs
•• Document expiration
•• Merge files
•• Live Edit
•• OpenMeetings



http://wiki.openkm.com/index.php?title=Cryptography
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System access
System access is performed via a web browser using the URL where your OpenKM installation is hosted. In the
access screen you must enter the user name (Login) and the password that has been provided by the system
administrator.


Up to version 4
Language can not be selected.



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_092.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_001.jpeg
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Desktop screen
On accessing the system, a desktop is displayed with five different well-defined workspaces: Menu Options,
Toolbar, Folder Tree, Document Browser and Document and Folder Properties, as well as information on the user
who is connected at that time.



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_003.jpeg
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Menu bar
The menu bar is formed by all the pull down menus with their different options. If an option within a menu appears
greyed-out, this option is not available.


Detail of the functions according to their icons:
•  → Create a new folder
•  → Add new document
•  → Download document
•  → Send document link
•  → Send document attachment
•  → Empty trash
•  → Exit application
•  → Lock document
•  → Unlock document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Move document to user’s Trash.
•  → Copy document
•  → Move document
•  → Rename document
•  → Submenu of available languages
•  → Submenu of available skins
•  → Debug console in event of errors
•  → Skip to folder or document set as home by the user
•  → Add document or folder to bookmark list
•  → Edit bookmark list
•  → Link to OpenKM documentation
•  → Link to report errors (bugs)
•  → Link to Support-request form
•  → Link to forum
•  → Link to changes in each version (changelog)
•  → Link to application website
•  → Application information
•  → Download file as pdf
•  → Export to ZIP
•  → Administration



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_093.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_005.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_006.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_007.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_008.jpeg

http://wiki.openkm.com/index.php?title=File:Add_folder.gif

http://wiki.openkm.com/index.php?title=File:Add_document.gif

http://wiki.openkm.com/index.php?title=File:Download.gif

http://wiki.openkm.com/index.php?title=File:Send_document_link.gif

http://wiki.openkm.com/index.php?title=File:Send_document_attachment.gif

http://wiki.openkm.com/index.php?title=File:Purge_trash.gif

http://wiki.openkm.com/index.php?title=File:Exit.gif

http://wiki.openkm.com/index.php?title=File:Lock.gif

http://wiki.openkm.com/index.php?title=File:Unlock.gif

http://wiki.openkm.com/index.php?title=File:Checkout.gif

http://wiki.openkm.com/index.php?title=File:Checkin.gif

http://wiki.openkm.com/index.php?title=File:Cancel_checkout.gif

http://wiki.openkm.com/index.php?title=File:Delete.gif

http://wiki.openkm.com/index.php?title=File:Copy.gif

http://wiki.openkm.com/index.php?title=File:Move_document.gif

http://wiki.openkm.com/index.php?title=File:Rename.gif

http://wiki.openkm.com/index.php?title=File:Language.gif

http://wiki.openkm.com/index.php?title=File:Skin.gif

http://wiki.openkm.com/index.php?title=File:Console.gif

http://wiki.openkm.com/index.php?title=File:Bookmark_go.gif

http://wiki.openkm.com/index.php?title=File:Add_bookmark.gif

http://wiki.openkm.com/index.php?title=File:Bookmark_edit.gif

http://wiki.openkm.com/index.php?title=File:Documentation.gif

http://wiki.openkm.com/index.php?title=File:Bugs.gif

http://wiki.openkm.com/index.php?title=File:Support.gif

http://wiki.openkm.com/index.php?title=File:Forum.gif

http://wiki.openkm.com/index.php?title=File:Brick.gif

http://wiki.openkm.com/index.php?title=File:Home.gif

http://wiki.openkm.com/index.php?title=File:About.gif

http://wiki.openkm.com/index.php?title=File:Download_pdf.gif

http://wiki.openkm.com/index.php?title=File:Export.gif

http://wiki.openkm.com/index.php?title=File:Administration.gif
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Toolbar
The toolbar is made up of buttons with the main functions that the user will most frequently use. As with the menu
bar, occasionally the buttons will appear greyed-out, meaning that they are not available.


Detail of the functions according to their icons:
•  → Create a new folder
•  → Find a folder
•  → Download document
•  → Download as pdf document
•  → Lock document
•  → Unlock document
•  → Add new document
•  → Print a document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Move document to user’s Trash.
•  → Add group of properties to a document ( metadata )
•  → Delete group of properties from a document ( metadata )
•  → Subscription is added to a document or folder. Any modification that is made will be notified to the user by


email.
•  → Delete subscription to a document or folder
•  → Start workflow
•  → Refresh user interface
•  → Skip to folder or document set as home by the user
•  → Scanning
•  → Uploading
•  → Application splitters resize



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_094.jpeg

http://wiki.openkm.com/index.php?title=File:Add_folder.gif

http://wiki.openkm.com/index.php?title=File:Folder_find.gif

http://wiki.openkm.com/index.php?title=File:Download.gif

http://wiki.openkm.com/index.php?title=File:Download_pdf.gif

http://wiki.openkm.com/index.php?title=File:Lock.gif

http://wiki.openkm.com/index.php?title=File:Unlock.gif

http://wiki.openkm.com/index.php?title=File:Add_document.gif

http://wiki.openkm.com/index.php?title=File:Printer.png

http://wiki.openkm.com/index.php?title=File:Checkout.gif

http://wiki.openkm.com/index.php?title=File:Checkin.gif

http://wiki.openkm.com/index.php?title=File:Cancel_checkout.gif

http://wiki.openkm.com/index.php?title=File:Delete.gif

http://wiki.openkm.com/index.php?title=File:Add_property_group.gif

http://wiki.openkm.com/index.php?title=File:Remove_property_group.gif

http://wiki.openkm.com/index.php?title=File:Add_subscription.gif

http://wiki.openkm.com/index.php?title=File:Remove_subscription.gif

http://wiki.openkm.com/index.php?title=File:Start_workflow.gif

http://wiki.openkm.com/index.php?title=File:Refresh.gif

http://wiki.openkm.com/index.php?title=File:Bookmark_go.gif

http://wiki.openkm.com/index.php?title=File:Scanning.gif

http://wiki.openkm.com/index.php?title=File:Upload.gif

http://wiki.openkm.com/index.php?title=File:Application_resize.png
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User identification
In this space of the desktop screen the user who is connected in this session is identified.


In the event of detecting a user with AdminRole as the user, the identifier will appear in another colour, with the
purpose of indicating that operations are being carried out under a “super-user” without any restrictions on document
access.


Changes from version 3.0 to 4.0
In OpenKM version 3.0 and older, there was only one username with administrator access called okmAdmin.


Status bar
In this space of the desktop screen the user has access to some general information like his repository size used,
number of locked documents, number of checkout documents ( edited ), subscribed folders and documents, number
of news items pending to read and number of workflow task pending that have been assigned to the user.


At the right corner, there's a status message bar that OpenKM uses to show some information to users.


Workspace
The workspace allows you to change between Search and the list of folders and documents.


There are four tabs to enable the four work modes:
• Desktop: Mode to carry out the main tasks with folders and their documents (create, add, move, download, etc.).
• Search: Mode to search documents.
• DashBoard: Mode to access workflow, user documents view, general document view and news push service.
• Administration: Administration utilities, only available for users with AdminRole access.


Changes from version 3.0 to 4.0
In OpenKM 3.0 and older versions, administration tab was only accessible by the okmAdmin user.



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_010.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_011.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_012.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_013.jpeg
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Path
The path always indicates your location within the tree (Taxonomy, Thesaurus, Personal, etc. depending on the view
you have enabled at any given moment).


Taxonomy
Firstly, on the left of the desktop, is the Folder Tree, also called the Taxonomy. It displays a view of the repository
grouped by folders. There are various types of folders symbolised by the following icons:
•  → The folder has no more subfolders
•  → The folder contains subfolders
•  → The folder is read-only and has no more subfolders
•  → The folder is read-only and contains subfolders
•  → You are subscribed to the folder and it has no more subfolders
•  → You are subscribed to the folder and it contains subfolders
•  → You are subscribed to the folder, it contains no subfolders and is read-only
•  → You are subscribed to the folder, it contains subfolders and is read-only


Basic functions with the mouse
•• By clicking with the right mouse button a pop-up menu will appear. In this menu there are options to create new


folders, delete, rename, etc.
• Drag & drop. By selecting a document or folder and keeping the left mouse button held permanently down, you


can move a document or folder to a node of the tree (Taxonomy).
Pop-up menu


Description of the different options


•  → Create a new folder
•  → Delete folder.
•  → Change the name of the selected folder.
•  → Change the location of the selected folder to another position on the tree, together with all the documents


and folders it may contain
•  → Duplicate the folder and its contents in another place on the tree.
•  → Add new document
•  → Add a folder or document to the bookmarks



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_014.jpeg

http://wiki.openkm.com/index.php?title=File:Menuitem_empty.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_childs.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_empty_ro.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_childs_ro.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_empty_subscribed.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_childs_subscribed.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_empty_ro_subscribed.gif

http://wiki.openkm.com/index.php?title=File:Menuitem_childs_ro_subscribed.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_015.jpeg

http://wiki.openkm.com/index.php?title=File:Add_folder.gif

http://wiki.openkm.com/index.php?title=File:Delete.gif

http://wiki.openkm.com/index.php?title=File:Rename.gif

http://wiki.openkm.com/index.php?title=File:Move_folder.gif

http://wiki.openkm.com/index.php?title=File:Copy.gif

http://wiki.openkm.com/index.php?title=File:Add_document.gif

http://wiki.openkm.com/index.php?title=File:Add_bookmark.gif
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•  → Set the folder or document as user home
•  → Create a zip file with all the contents of the folder recursively, maintaining the folder structure.


Document browser
In the upper section of the screen the document browser can be seen. The document browser allows you to view the
list of documents and subfolders available on a specific node of the tree (Taxonomy).


Basic functions with the mouse
•• Double-click with the left button on a folder to open the folder.
•• Double-click with the left button on a document to download the document.
•• Right-click and a pop-up menu will appear.
• Drag & drop. By selecting a document or folder and keeping the left mouse button held down, you can move a


document or folder to a node of the tree (Taxonomy).
Pop-up menu


Description of the different options
•  → Download document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Lock document
•  → Unlock document
•  → Move document to user’s Trash.
•  → Change the name of the selected folder or document.
•  → Change the location of the folder or document selected to another place on the tree
•  → Duplicate the folder and its contents or another document to another place on the tree.
•  → Add a folder or document to the bookmarks



http://wiki.openkm.com/index.php?title=File:Bookmark.gif

http://wiki.openkm.com/index.php?title=File:Export.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_016.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_95.jpeg

http://wiki.openkm.com/index.php?title=File:Download.gif

http://wiki.openkm.com/index.php?title=File:Checkout.gif

http://wiki.openkm.com/index.php?title=File:Checkin.gif

http://wiki.openkm.com/index.php?title=File:Cancel_checkout.gif

http://wiki.openkm.com/index.php?title=File:Lock.gif

http://wiki.openkm.com/index.php?title=File:Unlock.gif

http://wiki.openkm.com/index.php?title=File:Delete.gif

http://wiki.openkm.com/index.php?title=File:Rename.gif

http://wiki.openkm.com/index.php?title=File:Move_folder.gif

http://wiki.openkm.com/index.php?title=File:Copy.gif

http://wiki.openkm.com/index.php?title=File:Add_bookmark.gif
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Up to version 4.x and above
Previewing of images and videos is done in separate popup windows. From version 5.x and above, preview
enhancement is integrated in only one panel for all document mime types. Play a multimedia file and Display images
popup menu are only available in version 4.x and older.


Description of the different options
•  → Play a multimedia file: FLV, MP3, WAV, etc
•  → Display images without having to download them, type: GIF, JPG, PNG, etc



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_017.jpeg

http://wiki.openkm.com/index.php?title=File:Media_preview.gif

http://wiki.openkm.com/index.php?title=File:Image_viewer.gif
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Properties panel
In the lower part of the screen are detailed the Document or folder properties with security, history, general
properties and specifics concerning documents defined by users (document parameterization).


Options available for folders
•• Security tab.
•• Properties tab.


Options available for documents
•• Security tab.
•• Properties tab.
•• History tab (version control).
•• Notes.
•• Tabs of property groups.
•• Preview tab



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_095.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_096.jpeg
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Basic operations with documents and folders


Taxonomy
Taxonomy is defined as a knowledge tree via which the company organises its information. The side panel of the
desktop offers a view of the taxonomy of concepts, organised in a hierarchical folder structure.


Categories
Categories is defined as a knowledge tree via which the company organises its information - as a repository view
organized by categories and subcategories. The side panel of the desktop offers a view of the categories concepts,
organized in a hierarchical folder structure. This is only a special way to view the repository, but really the repository
is organized physically as you can see in the taxonomy view.


Thesaurus
A thesaurus is a book that lists words grouped together according to similarity of meaning (containing synonyms and
sometimes antonyms), in contrast to a dictionary, which contains definitions and pronunciations. Thesaurus is
defined as a knowledge tree via which the company organises its information - as a repository view organized by
terms. The side panel of the desktop offers a view of the terms concepts, organized in a hierarchical folder structure.
This is only a special way to view the repository, but really the repository is organized physically as you can see in
the taxonomy view.
The jerarquical relations between terms, depending about how thesaurus is defined.


Personal documents
The user’s personal documents is a personal knowledge tree of each user where they can save any type of document.
These are only accessible by the users themselves.


Templates
Contains document templates that can be used as a base by users to create other new documents.


E-mail
Contains imported personal emails, text and attached documents from the user's mail account using the IMAP mail
service.



http://en.wikipedia.org/wiki/IMAP
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Create folder
Operation icon: 
Available


•• Pop-up menu of the folder tree.
•• Main edit menu.
•• Toolbar.


Find folder
Allows to quickly find folders.
Operation icon: 
Available


•• Toolbar.
•• Menu file



http://wiki.openkm.com/index.php?title=File:Add_folder.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_021.jpeg

http://wiki.openkm.com/index.php?title=File:Folder_find.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_097.jpeg
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Inserting documents
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
•• Main edit menu.
•• Toolbar.


The option "Import documents from ZIP" allows you to import the contents of a zip file respecting the hierarchy of
the folder tree. When the insert window appears on the screen, select the local folder clicking the button "Browse...".
If you want to notify users that you have uploaded a new file by email, mark the checkbox "Notify users". Otherwise
leave this option unchecked. You can notify to users or groups.


To end, click "Send". Once the upload of the new document has finished, you can upload more documents with the
option "Add another file".



http://wiki.openkm.com/index.php?title=File:Add_document.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_022.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_098.jpeg
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For large organizations with many users, advanced filtering can be enabled using the Profiles administration feature.
It allows one to filter users and groups.



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_024.jpeg

http://wiki.openkm.com/index.php?title=Profiles

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_099.jpeg
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Up to version 4 and above
Does not have advanced filters and sending to groups.


Wizard
You can configure in user Profiles to allow a wizard while uploading a new document. Property groups ( metadata ),
keywords, and categories can be selected as a part of the wizard.


Property groups ( metadata )



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_023.jpeg

http://wiki.openkm.com/index.php?title=Profiles

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_022.jpeg
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Categories


Keywords



http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_100.jpeg

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_101.jpeg

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_102.jpeg
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Renaming
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
•• Main edit menu.
You can cancel the renaming option using the ESC key.


Renaming a folder


Renaming a document



http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_024.jpeg

http://wiki.openkm.com/index.php?title=File:Rename.gif

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_025.jpeg

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_026.jpeg
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Move
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
•• Main edit menu.
A dialogue box appears to select the new location of the document or folder: click Move. If you do not have
permission in the new location the Move button will appear disabled.



http://wiki.openkm.com/index.php?title=File:Move_document.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_027.jpeg
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Copy
Operation icon: 
Available


•• Pop-up menu of the folder tree.
•• Pop-up menu of the document browser.
•• Main edit menu.
A dialogue box to select the location to copy the document or folder to appears: click Copy. If you do not have
permission in the new location the Copy button will be disabled.



http://wiki.openkm.com/index.php?title=File:Copy.gif

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_028.jpeg
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Adding bookmark
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
Select the document or folder on which you want to do the operation. Execute the operation and a window will
appear in which you can put a description of the bookmark.


Once the bookmark has been created you can check that it appears in the general “Bookmark” menu. The bookmarks
are graphically distinguished depending on whether they are folders or documents, and ordered according to their
category and name.
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Set home
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
You can set any folder or document as the default home in the user environment.
In this way, on accessing the application, the path to the folder or document that has been set as home will open
automatically.
The operation to set a document or folder as home will always ask you for confirmation.


Deleting
Operation icon: 
Available


•• Pop-up menu of folder tree.
•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
Simply choose the folder or document and select the option "Delete". The application will always ask you for
confirmation of this option. When a document or folder has been deleted, you can restore it from Trash.
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Keyword shortcuts
There are some keyboard shortcuts that you can use with OpenKM.


On folders, documents and mails


F2 to rename


SUPR to delete


CTRL+SHIFT+C to copy


CTRL+SHIFT+X to cut


CTRL+SHIFT+V to paste


Others


F1 to show help


F5 to refresh the environment


INSERT to show popup for inserting documents


CTRL+ALT+Q to exit OpenKM


CTRL+D to download a document or email


CTRL+Z to enable debug console


CTRL+N to create a new folder


CTRL+B to show bookmarks


Version 5.0.3 and older


CTRL+Q to exit OpenKM







Uploading from desktop computer 25


Uploading from desktop computer
Operation icon: 
Available


•• Toolbar.
•• File menu.
At the center of the screen will appear the OpenKM logo. Simply drag and drop files or folders from your desktop
computer to the logo and the files or folders will be automatically uploaded to OpenKM, to your currently selected
folder path.


To close the uploader, simply right-click on the OpenKM logo and select Exit in the popup menu that appears.


Application splitters resize
Operation icon: 
Available


•• Toolbar.
Application resize allows maximize fastly any Desktop UI Panel or turn back to default UI panels size.


This feature in under development and currently not released with OpenKM.
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Document edit
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
To start to work with a file you must do a “Check-out” of it: that is, download the file to the local computer to be able
to modify it. Once you have made the pertinent modifications, upload it once again with a “Check-in”.
The automatic locking of the folder ensures that no other system user can modify its contents while you are
modifying it.


Cancel edit
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
If you want to cancel the document edit, the "Cancel Check-out" option exists whereby the file undergoes no type of
modification and it will be unlocked so that other users (depending on their privileges) can edit it.


Administrator force cancel edit
From OpenKM version 5.x, the option to cancel document editing is available for any user with administrator rights,
even though he may not be the user who started the editing. In this case, a confirmation popup will be shown to
cancel the document edit.
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Update a file
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
Once the changes have been made on the local computer, you must do a “Check-in” to upload the file once more to
the system and unlock it for future use.
The system will ask for the modified file to upload to the repository and notify you that it will replace the previous
version with this newer one.


The comment field is there to put information concerning the update of the file - for example, what changes have
been made.
You can send notification messages to user or groups. Additionally advanced filters can be enabled, useful for high
level users, that can be enabled in user Profiles.
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Up to version 4.x and earlier
Can only send mail notifications to users, and does not have advanced filtering options.
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Lock
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
If you want to protect the file so that no other user can make changes to it, you can use the Lock function. This
means that until it is unlocked, no other user can modify it. When locked, a locked icon will appear to the side of the
name of the selected file.


Unlock
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
The unlock option allows you to unlock a previously locked document. This operation can only be carried out by the
user who previously locked the document.


Administrator force unlock
From OpenKM version 5.x, the option to unlock a document is available for any user with administrator rights,
althought he may not be the user who locked the document. In this case, a confirmation popup will be shown before
unlocking the document.
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Downloading a document
Operation icon: 
Available


•• Pop-up menu of document browser.
•• Edit menu.
•• Toolbar.
If you want to save a file on the local computer without making any changes you can use the option "Download".
Remember that if you modify the downloaded file you cannot upload it again to the system without having first done
a "Check-out /Check-in" of the file.


Adding a metadata to a document
Operation icon: 
Available


•• Toolbar
Property groups are groups of configurable parameters that can be configured each time the application is installed,
which allow for the categorization of documents. These property groups can be Input, Simple List, Multiple Select
List, Text area, Date, Link or OpenKM folder path. The values of these properties are internationalised (various
languages).
To add a property group (these must first be registered by the administrator), simply select a document and select the
corresponding property group.


Once a property group has been added, a new tab will appear with the name of the corresponding group and fields
with it's properties.


Once a property group has been assigned to a document, you can modify its values by selecting the option "Modify".
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Parameterization is extremely useful. Combined with the Search function, it enables the location of information by
categories, it being possible to create metadata categories which are adapted to a user group’s working method.


Adding or deleting a property group will not affect the document history.


Deleting a metadata from a document
Operation icon 
Available


•• Toolbar.
This option enables you to delete a property group which at that moment is enabled in the properties panel.


Adding keywords
In the document properties tab of the properties panel, you can add and modify keywords. To add a keyword, type it
and hit Enter.
In order to optimise indexing and future information searches in the document management system, it is necessary to
enter keywords that describe or identify the stored file.
Although the document parameterization system by property groups is superior with regards to capacity, keywords
will continue to be maintained and will not disappear, as it is understood that in certain installations property groups
will not be created and it is useful that parameterization by default keywords is maintained.
Adding or deleting keywords does not modify the document version.
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Adding keywords from thesaurus
Keywords can be selected from the thesaurus. Click on the  thesaurus icon and a popup will appear with available
thesaurus keywords.


Adding categories
In the document properties tab of the properties panel, you can add and remove categories.
In order to optimise indexing and future information searches in the document management system, it is necessary to
add categories that describe or identify the stored file.
Although the document parameterization system by property groups is superior with regards to capacity, these will
continue to be maintained and will not disappear, as it is understood that in certain installations property groups will
not be created and it is useful that parameterization by default categories is maintained.
Adding or deleting categories does not modify the document version.
Categories are a hierachical folder structure of folder and subfolders.
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Adding categories
Categories can be selected from the available categories folder structure.
Click on the  categories icon and a popup will appear with available categories.


Deleting categories
Click on the  delete icon of a category and it'll be deleted from the document.
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Copy to clipboard
Copy the document url (OpenKM browser path) to clipboard. Note in some browsers like Firefox you might
configure browser to enable this option (security browser restrictions).
To enable JavaScript "Copy to clipboard" buttons on Firefox and Mozilla, enter the following line into browser
address bar: about:config.
The list of preferences should open in browser window. Click right mouse button somewhere in active part of
preference list window and choose New > Boolean option from context menu. Paste the following Preference name
into the New boolean value window input box: signed.applets.codebase_principal_support.


Since OpenKM 5.0 this feature is implemented using Flash and you don't need to change your browser configuration because just
works!.


Send document as attachment
To send a document to some OpenKM user as an email attachment, first select the document to send. Then open the
File menu and select the option "send document attachment". A popup will appear in which the user or groups to
send the document to can be selected.
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Fast select and unselect
In filebrowser is available checkbox to select several documents, folders and mails and apply actions together.


The icon  available in filebrowser open the fast select and unselect filebrowser rows.
The available options are:
•• Select all rows
•• Select all folder rows
•• Select all document rows
•• Select all mail rows
•• Unselect all rows
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Massive delete
Select some filebrowser rows.


Execute the action delete  will be shown a confirmation popup.


Click Accept button. All selected rows will be deleted.
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Massive move
Select some filebrowser rows.


Execute the action move  will be shown a destination folder popup.


Click Move button. All selected rows will be moved to destination folder.
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Massive copy
Select some filebrowser rows.


Execute the action copy  will be shown a destination folder popup.


Click Copy button. All selected rows will be copyed to destination folder.
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Massive add note
Select some filebrowser rows.


Execute the action add note  will be shown a popup.


Write the note and Click Add button. The note will be added in each selected rows objects.
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Massive add category
Select some filebrowser rows.


Execute the action add category  will be shown a popup.


For each category to be added, select the category and Click Add button. The category will be added in each selected
rows objects. Optionally any new added category can be removed.
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Massive add keyword
Select some filebrowser rows.


Execute the action add keyword  will be shown a popup.


Write a keyword and Click Add button. The keyword will be added in each selected rows objects. Optionally any
new added keyword can be removed.
If thesaurus is enabled can select keyword from theaurus using the thesaurus icon  will appearing the thesaurus
popup.
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Massive property group
Select some filebrowser rows.


Execute the action add property group  will be shown a popup.


Select the property group and Click Add button will be shown property group fields.


Fill the fields and Click Add button. The property group will be added in each selected rows objects.
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Extra columns
In administration Profiles can be set file browser extra columns based in property groups.


After updating profile, user desktop filebrowser will be shown with extra columns.
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Pagination
Pagination allows users nagivate across great size repositories. If Extra_columns are enabled can ordering and
filtering for it too.


Available features:
•  → Show / hide folders
•  → Show / hide documents
•  → Show / hide mails
•  → change filterning options
•  → next
•  → previous
•  → goto start
•  → goto end
Filtering options:
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Categories
Categories is a hierarchical tree structure of category and subcategory folders. The idea is that folders and subfolders
represent some conceptual tree structure.


A document can be linked with many category folders at same time. Each time some category folder is selected, all
related documents will be displayed in file browser panel. All the major document functionalities are available from
this view.
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Metadata view


This feature will be present in OpenKM 6.0


Metadata view is a hierarchical tree structure of metadata groups ( property groups ). Each possible metadata value is
represented as a tree node structure.


Only Select and SuggestBox metadata types are represented on metadata view. With metadata view can only browser defined closed
values declarated. Metadata types like input or textarea are not represented on the metadata tree structure view.


A document, folder or mail can be linked with many metadata property values folders at the same time. Each time
some metadata value folder is selected, all related documents, folders or mails will be displayed in the file browser
panel. All the major document, folder or mail functionalities are available from this view.
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Thesaurus view
A thesaurus is a book that lists words grouped together according to similarity of meaning (containing
synonyms and sometimes antonyms), in contrast to a dictionary, which contains definitions and pronunciations.
Thesaurus view is a hierarchical tree structure of SKOS (Simple Knowledge Organization System) folders. SKOS
concepts are linked many to many, but are represented as a tree structure.


A document, folder or mail can be linked with many SKOS folders at the same time. Each time some SKOS folder is
selected, all related documents, folder or mails will be displayed in the file browser panel. All the major document,m
folder or mail functionalities are available from this view.
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My documents
My documents is a tree folder structure to organise a user's personal documents. The documents are only available to
the owner.


From version 5.x and above, any user with administrator rights can navigate across all users "My documents" folder
structure.
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Templates
Templates is a tree folder structure to organise source documents. The idea is that an organization can create new
documents ( for example fax, new project document templates, invoices, etc. ) from documents in the templates
panel.


Create new document from template
First, from the Templates panel, select a document, and execute the option "create from template". A popup will
appear requesting the destination folder.


After that, optionally rename the document.
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If the selected document is a pdf and has some Property_Groups (metadata) associated with it, then a creation wizard
popup will appear. Property group fields will be requested in order to combine with the generation of the new PDF.
You can create PDF forms with several applications:
• Acrobat Pro [1]


• How-to: Create PDF forms with OpenOffice [2]


• PDF Forms Designer [3]
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The wizard


And finally, the generated PDF with property group fields added by the user.
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After that, optionally rename the document.
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OpenKM 5 and above
First, from the Templates panel, select a document, and execute the option "create from template". A popup will
appear requesting the destination folder.


After that, optionally rename the document.


See also Creating templates.


References
[1] http:/ / www. adobe. com/ products/ acrobat. html
[2] http:/ / danilop. wordpress. com/ 2008/ 07/ 02/ how-to-create-pdf-forms-with-openoffice/
[3] http:/ / pdfformsdesigne. sourceforge. net/ index. html
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E-mail
Import users emails from some user mail account using IMAP. Importation is done automatically by OpenKM every
60 minutes. Depending on the network bandwidth configuration and other parameters, refreshing time could be
greater that this.


Attached documents are indexed too.


The importing mechanism creates a folder structure based on year, month and day to automatically organize
imported mails.


From version 5.x users with adminitrator rights have access to all users emails.


Copy attached document
Right-clicking on a document and selecting the "Copy" option will bring up a menu to select the destination folder to
copy the attached document.


Download attached document
Right-clicking on a document and selecting the "Download" option will download the attached document.
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Trash
Deleted files and folders are stored in Trash in order to be able to recover them if their deletion was accidental.
Trash, as well as the files located in it, are personal to each system user.
•• Restoring a folder or document
•• Definitively deleting a folder or document
•• Emptying trash


From version 5.x users with adminitrator rights have access to all users Trash.
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Using information
In the properties panel there is detailed information on the documents and folders to which the user has access.
•• Folder information tabs
•• Document information


Security
The security option allows you to show and define what users and groups have permission to a specific document or
folder.
•• Modifying security


Search
The Search tab, located in the upper right of the screen, changes the desktop panels for those of Search.
Searches may be made by words in the contents of the files, by the name (title) of the documents, or by the type of
file (MIME type). Similarly, providing a keyword has been provided for the files, you can search using this field.
You can also do searches by property group values if they have been defined.
The results are displayed paginated with 10, 20 or 30 results.
Stars indicate the relevance of the document found. This value is established by the Search engine according to the
search field and the results found. The list of documents found is ordered from most to least relevant.


•• Fast search
•• Making a search
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•• Executing a stored query
•• Deleting a stored query
•• Opening the location of a document
•• Opening the location of a folder
•• Save as a user news
•• Searching with OpenKM


Dashboard
The Dashboard tab, located in the upper right of the screen, changes the desktop panels for those of the Dashboard.
The Dashboard has several information services and utilities for like user, general and email documents, specific
document query views, the push search service ( news ), workflow tasks, and the keyword map ( tag cloud view ).


To change between these utilities there's a button menu at the top. The selected option is always marked in blue.


•• User view
•• General view
•• Dashboard keyboard map
•• Dashboard mail
•• Dashboard news
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Notification service
The application permits notification by email of the creation or update of a new document.
The user to whom the application has sent a notification by email will see a message with a direct link (URL) to the
document, the user who has caused the notification, and a message (description) if the user has supplied one. The
"subject" of the email received by the user will be something similar to the following:


OpenKM - NOTIFICATION - "Document Name"


The user can create a filter in their mail client with the name "OpenKM" or "OpenKM - NOTIFICATION" to
centralise in one single folder all notifications generated by the OpenKM.


Subscription service
The application allows you to subscribe to a folder or document with the purpose of being informed of the changes
on one document in particular, or the documents contained in a particular folder.
These are some of the events which generate a notification:
•• Cancelling a document edit
•• Uploading modifications of a document
•• Copying a document
•• Creating a document
•• Setting the properties of a document
•• Unlocking a document
•• Making a subscription
•• Deleting a subscription
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Starting a Workflow
After selecting a document, click on the  start workflow icon, then a popup will appear with the workflows
available in OpenKM.


After pressing start button, the workflow will automatically start ( sometimes workflow demands some extra
parameter information before starting ), assigning the first pending task to some user or group.


Workflow pending task
On the Desktop, when a user has a pending workflow task, at the bottom there'll be a  blinking icon that indicates
the user has a pending task. Clicking on the  pending task icon will open the dashboard workflow view.


User has some associated pending tasks.
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On selecting a pending task, workflow will demand for some information about the pending task. After the user has
input this information, workflow will continue to the next task.


User configuration
Users can change their own password, email address and optionally configuring their imap email account ( it'll be
automatically read periodically by OpenKM )
To show user configuration, open the Tools | Preferences menu and then select the option "user configuration".
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Languages
OpenKM is a multi-language system which allows you to change the language of the user interface at any time
during the session. In the "Tools / Languages" menu, you can select any of the languages installed by the
administrator.


Appearance
The graphical appearance of the system can be changed by the user depending on the templates defined by the
administrator. This option is available from the "Tools / Appearance" menu.
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Using iPhone or Android
You can use your iPhone or Android device to access OpenKM.
You must use the same URL. OpenKM automatically detects if you're using an iPhone or Android device. Note that
not all OpenKM features are enabled in this view.


Navigation


Making a search
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To download a document, simply click on it.
To view properties, click on the right arrow.
Document properties


Folder properties
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Help
This menu, as well as providing help on the functioning of OpenKM, allows you to send comments and error
notifications (bugs) to the system developers.
There is, furthermore, the option of requesting support via the web on the system operation, or to access the
OpenKM discussion forums. Other options include access to the project website (http:/ / www. openkm. com) and
the display of product credits.
In the version notes you can find the changes that have been made compared to the previous version.
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Microsoft Office Addin
Office Add-ins are compatible from version 2000 to version 2007


Oulook Add-in
Outlook_addin enables users to select several emails and import content and attachments to OpenKM.
Importing mail creates a folder structure based on received email date ( year/month/day folder structure ) and
imports into the mail content OpenKM mail tab view.


Word Add-in
Word Addin enables users to upload new files and edit existing OpenKM files.
When a user uploads new files, he browses across the OpenKM tree view to select where he wants to upload the file.
The OpenKM Word Add-in detects if the document opened by a user is an OpenKM file and enables or disables
some toolbar options.


Excel Add-in
Excel Addin enables users to upload new files and edit existing OpenKM files.
When a user uploads new files, he browses across the OpenKM tree view to select where he wants to upload the file.
The OpenKM Excel Add-in detects if the document opened by a user is an OpenKM file and enables or disables
some toolbar options.


PowerPoint Add-in
PowerPoint Addin enables users to upload new files and edit existing OpenKM files.
When a user uploads new files, he browses across the OpenKM tree view to select where he wants to upload the file.
The OpenKM PowerPoint Add-in detects if the document opened by a user is an OpenKM file and enables or
disables some toolbar options.


When a user edits a document, it's saved locally in %USER_LOCAL_DOCUMENT_FOLDER%/OpenKM.


When editing OpenKM documents, a user can decide to upload or cancel editing. After both operations the local file is removed so as
not to generate user confusion. When a user uploads a new file, it is not removed from his computer.
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Outlook addin
Office Add-ins are compatible from version 2000 to version 2007.
After installing the Outlook add-in, a new menu item "OpenKM" will appear in Outlook.


Configure OpenKM Add-In
First you must select the Configuration menu item to set your configuration values to access OpenKM from the
client computer.


When you set your configuration values, a folder called OpenKM is created in your user My documents folder. In
this OpenKM folder, a configuration file called openkm.xml and another file called document.xml are created that
the OpenKM Add-in uses to store some document editing information. You should not edit or delete these files.



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_076.jpeg

http://wiki.openkm.com/index.php?title=File:Okm_user_guide_077.jpeg





Outlook addin 69



http://wiki.openkm.com/index.php?title=File:Okm_user_guide_078.jpeg





Outlook addin 70


Importing emails to OpenKM
After configuration is done, the user can import emails from Outlook to OpenKM. To import emails, first select one
or more emails and then select the Import mail into OpenKM option menu. After importing is finished, a message
indicating the number of emails and attachments imported will be displayed.


OpenKM Outlook add-in runs with OpenKM 4.1 or higher.
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Word Addin
Office Add-ins are compatible from version 2000 to version 2007.
After installing the Word add-in, a new menu item "OpenKM" will appear in Word.


Detail of the functions according to their icons:


•  → Addin configuration
•  → Add new document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Help


Configure OpenKM Add-In
First you must select the OpenKM tool bar option to set your configuration values to access OpenKM from the client
computer. If you've got other OpenKM Add-Ins already installed, this may not be needed.


When you set your configuration values, a folder called OpenKM is created in your user My documents folder. In
this OpenKM folder, a configuration file called openkm.xml and another file called document.xml are created that
the OpenKM Add-in uses to store some document editing information. You should not edit or delete these files.
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Uploading a new file
After clicking on the  add new document button, a folder tree view will appear. You must select the folder where
you want to upload the file.


Click on the Send Button and after that the document will be uploaded to OpenKM and a notification message will
appear.
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Editing an OpenKM document
After clicking on the  document edit button, a folder navigator will appear. You must navigate across folders and
select a document that you want to edit.


When you've got some OpenKM document opened, the  Upload modified document (check-in) and  Cancel
document edit toolbar options will be enabled.
• To upload modified document, use the  Upload modified document (check-in) toolbar button.
• To cancel document editing, use the  Cancel document edit toolbar button.


After editing, your local document copy will be deleted to prevent user confusion.


OpenKM Word Add-in runs with OpenKM 4.1 or higher.
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Excel Addin
Office Addins are compatible from version 2000 to version 2007.
After installing the Excel add-in, a new menu item "OpenKM" will appear in Excel .


Detail of the functions according to their icons:


•  → Addin configuration
•  → Add new document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Help


Configure OpenKM AddIn
First you must select the OpenKM tool bar option to set your configuration values to access OpenKM from the client
computer. If you've got other OpenKM Add-Ins already installed, this may not be needed.


When you set your configuration values, a folder called OpenKM is created in your user My documents folder. In
this OpenKM folder, a configuration file called openkm.xml and another file called document.xml are created that
the OpenKM Add-in uses to store some document editing information. You should not edit or delete these files.
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Uploading a new file
After clicking on the  add new document button, a folder tree view will appear. You must select the folder where
you want to upload the file.


Click on the Send Button and after that the document will be uploaded to OpenKM and a notification message will
appear.
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Editing an OpenKM document
After clicking on the  document edit button, a folder navigator will appear. You must navigate across folders and
select a document that you want to edit.


When you've got some OpenKM document opened, the  Upload modified document (check-in) and  Cancel
document edit toolbar options will be enabled.
• To upload modified document, use the  Upload modified document (check-in) toolbar button.
• To cancel document editing, use the  Cancel document edit toolbar button.


After editing, your local document copy will be deleted to prevent user confusion.


OpenKM Excel Add-in runs with OpenKM 4.1 or higher.
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PowerPoint Addin
Office Add-ins are compatible from version 2000 to version 2007.
After installing the PowerPoint add-in, a new menu item "OpenKM" will appear in PowerPoint.


Detail of the functions according to their icons:


•  → Addin configuration
•  → Add new document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Help


Configure OpenKM Add-In
First you must select the OpenKM tool bar option to set your configuration values to access OpenKM from the client
computer. If you've got the OpenKM Add-In already installed, this may not be needed.


When you set your configuration values, a folder called OpenKM is created in your user My documents folder. In
this OpenKM folder, a configuration file called openkm.xml and another file called document.xml are created that
the OpenKM Add-in uses to store some document editing information. You should not edit or delete these files.
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Uploading a new file
After clicking on the  add new document button, a folder tree view will appear. You must select the folder where
you want to upload the file.


Click on the Send Button and after that the document will be uploaded to OpenKM and a notification message will
appear.
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Editing an OpenKM document
After clicking on the  document edit button, a folder navigator will appear. You must navigate across folders and
select a document that you want to edit.


When you've got some OpenKM document opened, the  Upload modified document (check-in) and  Cancel
document edit toolbar options will be enabled.
• To upload modified document, use the  Upload modified document (check-in) toolbar button.
• To cancel document editing, use the  Cancel document edit toolbar button.


After editing, your local document copy will be deleted to prevent user confusion.


OpenKM PowerPoint Add-in runs with OpenKM 4.1 or higher.
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OpenOffice.org Add-on


OpenOffice Add-In
OpenOffice Add-In is compatible from OpenOffice version 3.2 and OpenKM repository 4.x
After installing OpenOffice Add-In, "OpenKM" appears as a new toolbar. It usually appears in the top-left of the
OpenOffice window.


Details of the functions according to their icons:
•  → Add-in configuration
•  → Add new document
•  → Document edit ( check-out )
•  → Upload modified document (check-in)
•  → Cancel document edit
•  → Help


Configure OpenKM Add-In
First you must select the OpenKM tool bar option to set your configuration values to access OpenKM from the client
computer. If you've got the OpenKM Add-In already installed, this may not be needed.


When you set your configuration values, a folder called OpenKM is created in your user My documents folder. In
this OpenKM folder, a configuration file called openkm.xml and another file called document.xml are created that
the OpenKM Add-in uses to store some document editing information. You should not edit or delete these files.
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Uploading a new file
Before you begin, make sure the file you wish to upload is a) saved to disk (or OpenKM with throw an error) and b)
has the file name you wish it to have within the OpenKM repository otherwise you will have to go through the
OpenKM web interface to change the filename (true up to at least OpenKM 5.0)). After clicking on the add new
document button -  , a folder tree window appears. You must select a folder within this window before you are
allowed to upload the file.
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Once you've found the correct folder, highlight it and click the Add Button, and the document will be uploaded to
OpenKM. Once the process is complete a notification window will pop-up.
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Edit an OpenKM document
After clicking on the  document edit button, a folder navigator will appear. You must navigate across folders and
select a document that you want to edit.


When you've got some OpenKM document opened, the  Upload modified document (check-in) and  Cancel
document edit toolbar options will be enabled.
• To upload modified document, use the  Upload modified document (check-in) toolbar button.
• To cancel document editing, use the  Cancel document edit toolbar button.


After editing, your local document copy will be deleted to prevent user confusion.


OpenKM Open Office Add-in runs with OpenKM 5.x or higher.


Troubleshooting
Linux users must remember to install the following packages:


openoffice.org-java-common


openoffice.org-java
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Stapling
Stapling is only allowed in taxonomy, categories and thesaurus view. Folders, documents and mails can be stapled.
Same folder, document or mail can be stapled several times in different groups.
Restrictions:


•• Only the stapling creator has privileges to add / delete more elements or deleting entire group. Other users only
have downloading option.


•• Mails can not be downloaded.
•• If some users have no rights to download some document in a stapling, although they can see it in the stapling


group, they cannot download that file.
Detail of the functions according to their icons:
•  → Start new stapling group / Staple element ( same button has both functions ).
•  → Stop stapling group.
•  → Delete some element in the group.


Add new stapling group
First select some folder, document or email.


Folder, document or email must be selected in file browser view.


Click on the  start new stapling group icon ( at the bottom right will appear the message "Stapling started").
Then select another folder or document and click again on the same icon  . Both elements are now stapled.
Continue selecting new elements and clicking on the same icon  to increase the number of elements stapled.
To finish, click on the  stop stapling group icon ( at the bottom right will appear the message "Stapling finished")
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Add more elements to a stapling group
Click on the "Add" button in order to select which group you want to add more elements to ( at the bottom right will
appear the message "Stapling started").
Continue selecting new elements and clicking on the same icon  to increase the number of elements stapled.
To finish, click on the  stop stapling group icon ( at the bottom right will appear the message "Stapling finished")


Autocad preview
AutoCAD previewer allows one to do some basic operations like zoom in/out, rotate, show/hide layers and print.
AutoCAD preview extension allows one to convert AutoCAD files to PDF and preview them or preview DXF files.
In the Tools menu, the AutoCAD option allows one to select which preview conversion is enabled.


This feature supports DXF [1] and DWG [2] formats.


See also:
•• Third-party software integration: Acme CAD Converter
•• Application configuration: Autocad previewer


Tools menu
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Toolbar


•  Printing
•


•  Zoom out
•  Zoom in
•  Cursor zooming
•  Move draw
•  Rotation
•  Home
•  Back
•  Forward


•  Rotate 90º left
•  Rotate 90º right
•  Fit on page
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Default DXF preview


Preview with zoom
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Preview with rotation
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Preview hiding layers


Default PDF preview
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References
[1] http:/ / en. wikipedia. org/ wiki/ DXF
[2] http:/ / en. wikipedia. org/ wiki/ DWG


Messaging
Messaging extension allows to propose documents and folders to users, share normal queries and user news queries
with other users and sending of text messages to users.
Messaging extension widgets are located on the Tools menu ( send message option ), on any document / folder view
in taxonomy with an icon option to send proposed folder/document subscription, at the bottom of the desktop with
tree icons to indicate when new proposed subscriptions, proposed query or user messages have arrived and in
dashboard view where all information is available in one view.
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Description of the different icon options
•  → Proposed subscriptions
•  → Proposed query
•  → Message received
•  → Message sent


Proposing subscription
You can propose a subscription ( document / folder ) to any user or group of users ( based on roles ). Simply select
some document or folder and in the document or folder properties view will appear the propose subscription icon 
.


Click on the propose subscription icon  , and the propose subscription popup will appear.
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Select the users or group of users ( by roles ) you want to propose the subscription to. They'll receive the notification
in the messaging panel.


Proposed subscription notification
At the bottom of the Desktop panel with messaging extensions appears a tree of new icons. Periodically OpenKM
indicates to the end user if new messages have arrived.


Clicking on the proposed subscription icon  ( at bottom ), OpenKM automatically opens messaging view. In
propositions tab, the proposed subscriptions are ordered by the users who have sent them.


End user proposed subscription received
In Dashboard view, the end user can take advantage of OpenKM proposed subscriptions received from other users.
On selecting some proposed subscription, you've got several options. Clicking on the folder or document link will go
to the document or folder desktop location or simply pressing the subscribe option to make the subscription ( An
icon will appear to indicate you've already done this operation ). You can also delete a proposed subscription ( single
) or all proposed subscriptions with appropriate contextual menus in the stack and explorer panels.
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Proposing shared query
You can propose a shared query ( stored / users news ) to any user or group of users ( based on roles ). Simply select
some query in search view. In the contextual menu, the propose query icon  will appear.


Select users or group of users ( by roles ) you want to propose the query to. They'll receive the notification in the
messaging panel.
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Proposed query notification
At the bottom of the Desktop panel with messaging extensions appears a tree of new icons. Periodically OpenKM
indicates to the end user if new messages have arrived.


Clicking on the proposed query icon  ( at bottom ) makes OpenKM automatically open messaging view. In the
proposed queries tab, the proposed queries are ordered by the users who have sent them.


End user proposed queries received
In Dashboard view, the end user can take advantage of OpenKM proposed queries received from other users. On
selecting some proposed query you've got several options. Clicking on the query link will execute the query in search
view ( here, for example you can save as own ) or simply pressing accept option to accepting the shared query ( An
icon will appear to indicate you've already done this operation ). You can also delete a proposed query ( single ) or
all proposed queries with appropriate contextual menus in the stack and explorer panels.
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When the end user accepts a proposed query, this will appear in search view with the shared query icon  . The user
who proposed the query can modify it, meaning any change made by the owner of the query has immediate effects
on users with whom he's sharing.
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Sending messages
You can send a message to any user or group of users ( based on roles ). Simply open Tools menu / Messaging and
select the option send new message.


The new message popup will appear.


Select users or group of users ( by roles ) you want to send the message to. They'll receive the notification in the
messaging panel.
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New message notification
At the bottom of the Desktop panel with messaging extensions appears a tree of new icons. Periodically OpenKM
indicates to the end user if new messages have arrived.


Clicking on the new message icon  ( at bottom ) makes OpenKM automatically open messaging view. In the
message received tab, the messages are ordered by the users who have sent them.


End user messages received
In Dashboard view, end users can take advantage of OpenKM messages received from other users. On selecting
some message received you can see all message details. You can also delete a proposed query ( single ) or all
proposed by users with appropriate contextual menus in the stack and explorer panels.
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User messages sent view
Any kind of message sent by some user is registered ( proposed subscription / proposed query / message sent ) and
can be seen in the message sent view. All messages sent are ordered by the user who has sent them ( although it'll be
included in some role at the moment it was sent ). You can also delete a message sent ( single ) or all sent messages
using appropriate contextual menus is the stack and explorer panels.
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Downloading restricted buttons
Downloading restricted buttons extension is useful for administrators who want to share documents with external
users or some users but without downloading rights.


Enable
See Community extension section how to enable downloading restricted buttons in your OpenKM.


Description
Downloading restricted buttons is very simple to understand. Any user who doesn't have
NoDownloadingRestrictionRole cannot download files. That feature must be properly configured in accordance
with profiles options where default donwloading options might be disabled for all users. The idea is that only some
users will have the NoDownloadingRestrictionRole and will be able to download any document, if they have rights
to it.
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That solves the general problem that in some cases it is desired that some uses can read documents but not download
them.
When the extension is enabled, two new buttons will appear on the right of the toolbar.


In the next screenshot, the user doesn't have the role NoDownloadingRestrictionRole and that is the reason why
they cannot download the file ( take a look at the right corner of the toolbar ).


In the next screenshot, the user has the role NoDownloadingRestrictionRole that in combination with normal rights
allows the user to download the file ( take a look at the right corner of the toolbar ).
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Stamp
Stamp is only allowed in taxonomy view for any document which can be converted to PDF or is a PDF. In order to
stamp a document it's necessary to have working integration with OpenOffice. Take a look at OpenOffice.org or
Application_configuration.
Restrictions:


•• Only allowed for documents convertible to PDF or PDF files.
•• Have write privileges on folder.
•• Only allowed on taxonomy view.
Detail of the functions according to their icons:
•  → Start stamping a document
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Stamping a document
Fist select a document ( convertible to PDF or PDF ) in taxonomy view, then click  the stamp icon. A popup will
appear.


Several stamp types can be assigned in administration view to each user. A user must select one of the available
stamps he's got and execute it. After some time, a new PDF file will be generated ( or new version PDF file in case
the selected stamped file was a PDF ).


Stamp administration
In the administration, the stamps can be managed. You can create text or image based stamps.


You can add new stamps or edit existing ones.
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An Opacity equals to 0 means a transparent text or image and you won't see it. Set to 0.5 to see an semi-transparent text or set to 1 to be
opaque. Also play with layer to stamp over or below the default text layer.


In image stamp it's shown image stamp definitions.


In Expr. X and Expr. Y input fields you can put more than a simple number. Currently the following macros are defined:


•• IMAGE_WIDTH
•• IMAGE_HEIGHT
•• PAGE_WIDTH
•• PAGE_HEIGHT
•• PAGE_CENTER
•• PAGE_MIDDLE


So to center a stamp in the page you can use:


• Expr. X: PAGE_CENTER - IMAGE_WIDTH / 2
• Expr. Y: PAGE_MIDDLE - IMAGE_HEIGHT / 2


A new image can be added or you can edit the actual one.
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Using the test icon  you can generate a test file.
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Digital signature
Digital signature allow one to sign documents with installed certificates. You can sign an already uploaded document
or a new document. Only documents that can be converted to pdf can be signed. In case document is a pdf, then a
new document version is uploaded after signing. In case the document is to be converted, a new pdf file with same
name as the original document is uploaded in the same folder as the original.
Restrictions:


•• Only allowed for documents convertible to pdf or pdf files.
•• User must have access to insert or upload new file versions.
•• Only allowed in taxonomy view.
• Sign document is not possible in add document form with import document from ZIP option.


Sign an existing document
Select a pdf or a convertible file. Go to the Tools menu and select the sign document menu option.


A popup will appear. You must select the certificate you want to use to sign the document.
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When signing is finished, a popup message will appear.


In the history tab, one can see a comment "signed" and a version change if the original document was pdf file.
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Signing a new document
In case you want to sign a new document in OpenKM, simply check the option sign document in the add document
form.


If a wizard has been defined for the document, a sequence of screens will be available, and the last will be the sign
popup.
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When signing is finished, a popup message will appear.


In the history tab, one can see a comment "signed" and a version change if the original document was pdf file.
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If the document is a pdf, the original document will be uploaded and the signed one will be a new document version.
If document is not a pdf but only one convertible to pdf, then that document will be uploaded and a new signed pdf
file too.


Document encryption
Cryptography allows for additional document protection in OpenKM. With the cryptography extension, one can
upload a new encrypted document, encrypt and decrypt an existing document, edit and check in an encrypted
document and download and decrypt encryted documents. In order to make the cryptography process more secure,
files are encrypted and decrypted on the local user computer by a signed applet. That means any networking file
traffic is always with encrypted documents.
All Cryptography options are available from the Tools menu:
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Restrictions
•• Cryptography is only allowed in taxonomy view.
•• User must have write privileges on document and folder to perfom cyptography operations.
•• For editing purposes, the document should not be locked or checked out by another user.


Description of different icon options
•  → Add new encrypted document
•  → Encrypt document
•  → Edit encrypted document
•  → Checkin encrypted document
•  → Download decrypted document
•  → Decrypt document


Add new encrypted document
First select some folder in the taxonomy where you have write privileges to upload a document. Next, select the 
Add new encrypted document menu option. An encrypt popup will appear.


Now simply put your cryptopharase twice, and select the file to encrypt by clicking on the select file button. After
that the document will be encrypted locally with the cryptophrase and then uploaded to OpenKM. When the process
is finished, a popup message will appear indicating a successful upload.


The OpenKM document explorer UI will be refreshed and the newly uploaded document will appear with the
cryptography icon  indicating that it's an encrypted document.
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Download decrypted document
This operation downloads an encrypted document and decrypts it locally. First select some encrypted document in
OpenKM. Then select the  Download decrypted document option and a popup will appear for decrypting the
remote OpenKM document.


Next, put the decryptphrase and select the directory where you want to download the decrypted version of the
OpenKM document. OpenKM will then download the encrypted document to the local computer, decrypt and save.
After that an information popup will appear indicating that the document has been saved locally.
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Edit encrypted document
In order to edit an encrypted document, select the  Edit crypted document menu option. A decrypt popup will
appear.


Next, put the decryptphrase and select the directory where you want to download the decrypted version of the
OpenKM document. OpenKM will then download the encrypted document to the local computer, decrypt and save.
After that an information popup will appear indicating that the document has been saved locally.


The OpenKM document explorer UI will be refreshed and the document will appear, marked for editing.
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Check-in encrypted document
After making changes to the local document ( decrypted using Edit encrypted document menu option ), you must
upload a new document version to the OpenKM repository. First select the document that you want to upload to
OpenKM.


Then select the  Checkin encrypted document menu option. An encrypt popup will appear.


Now simply put your cryptopharase twice, and select the file by clicking on the select file button. After that, the
document will be encrypted locally with the cryptophrase and then uploaded to OpenKM. When the process is
finished, a popup message will appear indicating a successful upload.


The OpenKM document explorer UI will be refreshed and the document will appear as the latest version.
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Cancelling checkin can be done with the normal cancel checkin button available in the toolbar


Decrypt document
Decrypt document will decrypt an encrypted document in OpenKM and will replace it will a decrypted version. For
security reasons all previous encrypted document versions will be removed and replaced with the decrypted
document. The encrypted document will be downloaded and decrypted locally, then uploaded to OpenKM and the
version history purged.
First select an encrypted document in OpenKM.


Then select the  Decrypt document menu option. A decrypt popup will appear.
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Next, put the decryptphrase and select the Decrypt file button. The encrypted document will be downloaded and
decrypted locally and then uploaded to OpenKM, and version history will be purged too. An information popup will
appear indicating that the operation was done sucessfully.
The OpenKM document explorer UI will be refreshed and the decrypted document will appear as the latest version,
and with history purged.
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Encrypt document
Encrypt document will encrypt some unencrypted document in OpenKM and will replace it with the encrypted
version. For security purposes all previous document versions will be removed and replaced with the encrypted
document. The OpenKM document will be downloaded and encrypted locally, then uploaded to OpenKM and
version history purged.
First select some unencrypted document in OpenKM.


Then select the  Encrypt document menu option. The document will be downloaded locally, encrypted, uploaded
to OpenKM, and version history purged.


The OpenKM document explorer UI will be refreshed and the encrypted document will appear as the latest version,
and with history purged.
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Contacts
Contacts allow you to assign contacts to documents, folders and emails. There are two available options for this.
Manage contacts from the Tools menu and assign contacts using the Contacts tab on documents, folder or email
view.


Retrictions
•• You need write permissions to add a contact to some document / folder / email.
•• You need delete permissions to remove a contact from some document / folder / email.


Description of different icon options
•  → Manage contacts
•  → Add contact
•  → Edit contact
•  → Delete contact


Manage contacts
Go to the Tools menu and select the option Manage contacts.


A popup will appear.
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Double clicking on a contact or clicking on the edit contact icon  will allow editing.
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Selecting the update button will update the contact record. If you want to cancel editing, select the cancel button.
If you want to create a new contact from manage contacts view, select the new contact button. A new contact will
appear with empty fields. The Name field is mandatory.


Select the add button to save the contact record. If you want to cancel editing, select the cancel button.
If you want to delete a contact, click on the delete icon  . A confirmation popup will appear.
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Manage contact from tab view
On the document, folder or email view can appear managed contacts. Assign a contact to some document, folder or
email, or delete or update contact field values. For all these operations write permissions are needed on the
document, folder or email.


To add a new contact, select the add button. A popup will appear.


From the list appearing on the right, you can select some contact to be linked to a document, folder or email by
clicking on the contact icon  .
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Double clicking on the tab contact list or clicking on the edit icon  can edit the contact record ( you must have
write privileges on this view ).


Clicking on the delete icon  can delete the link between contact and document, folder or email. A confirmation
message will appear. In the tab view the contact record is not actually deleted. Only the link between contact and
document, folder or email is deleted.
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Activity log tab
Activity log tab allows you to see document, folder or email logs.
You can view all or filtered logs for the selected document, folder or email. The View get childs option filters the
get childs action, because that's one of the most common.
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Google contacts synchronization
This allows you to synchronize your Google contacts groups to OpenKM, import new contacts or update previously
imported contact information.


Synchronizing
Go to the Tools menu, select the menu Contacts and the sub menu Google Contacts Synchronization. The Google
Contacts Synchronization popup will appear. Put your username and password and then login.


If you have custom fields defined on Google Contacts you can map them to OpenKM ( for example on the
screenshot the custom fields are called propiedad1 and propiedad2 ).


Set the custom fields if you have defined some. Select the contact group you want to import and then list them.
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See if the mapping has been executed correctly. If all is alright, then you can synchronize contacts. Note that if
contacts have been imported before to the OpenKM, they'll be updated with actual Google values. If not, they'll be
inserted into OpenKM. After finishing synchronization, a message will appear at the top indicating that the operation
has been completed successfully.
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Forum
Forum allows for creating document, folder or email discussion topics or creating general purpose forums.
In Desktop view, you will see a new tab called forum where users can have discussions about documents, folders or
emails in several topics. Also in Dashboard view, they can access general purpose forums.


Retrictions
•• Only users with administrator rights can create, update or delete forums.
•• Only users with administrator rights can see the document discussions forum in dashboard view.
•• Nobody can delete document discussions forum ( document / folder / email discussion ).


Description of different icon options
•  → Edit forum / topic / contact
•  → Delete forum / topic / contact


Forum editor features


•• B - Bold
• I - Italic
•• U - Underline
•• p - Paragraph
•• Quote - Make a quotation
•• Img - Add image url.
•• Email - Add email.
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•• h1 to h6 - Header settings.
•• Align Left, center, justify and right.
•• Text size.
•• Font color palette.
•• Smilies


Create new topic
If you're in Desktop view, select the forum tab, and click on the create new topic button.


The post form will appear. Fill the fields.


Click on the create button and you will be forwarded to topic view with all posts.
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Create a reply
Enter into some topic, and at the top click on the post reply button.


You can also click on the Quote button in that view to reply some post


The post form will then appear. Fill the fields.


Click on the create button and you will be forwarded to topic view with all posts.



http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_247.jpeg

http://wiki.openkm.com/index.php?title=File:Nota_clasica.png

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_246.jpeg





Forum 132


Update a post
Enter into some topic, and click on an edit post icon  . The update post form will appear.


Click on the Update button and the post will be updated.


Delete a post
Enter into some topic, and click on a delete post icon  . A confirmation message will appear.


Click on the Accept button and the post will be deleted.


Topic features
•• To delete a topic, you must delete all posts.
•• Renaming the first post will rename the topic.


Create a forum
In dashboard view, click on the New forum button.


The forum form will appear.
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Click on the Create button. You will be forwarded to forum view.


There, you can create new topics.


Update a forum
In dashboard view, click on an edit forum icon  . The update forum form will appear.


Click on the Update button and the forum will be updated.
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Delete a forum
In dashboard view, click on a delete forum icon  . A confirmation message will appear.


Click on the Accept button and the forum will be deleted.


Wiki
Wiki allows fast creation and editing of any number of interlinked wiki pages and OpenKM documents and folders.
Multiple users can collaborate on it, creating, updating or deleting wiki information.
Each document, folder and email can have its own wiki. In the Dashboard, there's a general purpose wiki for all
OpenKM, where new wiki pages can be created linked with documents, folders among others.
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Wiki editor features


•• B - Bold
• I - Italic
•• U - Underline
•• p - Paragraph
•• Quote - Make a quotation
•• Img - Add image url.
•• Email - Add email.
•• h1 to h6 - Header settings.
•• Align Left, center, justify and right.
•• Text size.
•• Font color palette.
•• Smilies
•• Document link
•• Folder link
•• New wiki page
•• Wiki page link


Create new wiki page
If you're in Desktop view, select the wiki tab, and click on the create button.


The wiki editor will appear. Fill the content.


Click on the create button and you will be forwarded to wiki view.
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Update wiki page
If you're in Desktop view, select the wiki tab, and click on the update button.


The wiki editor will appear. Update the content.


Click on the update button and you will be forwarded to wiki view.



http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_266.png

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_267.png

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_268.png

http://wiki.openkm.com/index.php?title=File%3AOkm_user_guide_269.png





Wiki 137


History wiki page
If you're in Desktop view, select the wiki tab, and click on the history button.


The wiki history page will appear.


From this view you can view or restore older wiki pages.


Delete wiki page
If you're in Desktop view, select the wiki tab, and click on the delete button.


A confirmation popup will appear.


If you click on the accept button, the wiki page will be deleted ( database marked as deleted ). To restore, simply
create a new page with the same name and go to history. Deleted wiki pages can be deleted from there.
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Unlock wiki page
Wiki pages are updated by only one user at a time. While a page is being updated by this user, nobody else can
change it. The user who has locked the wiki page can directly unlock it by clicking on the unlock button ( normally
if a user from the edit view has pressed cancel or update, the wiki page will be unlocked ).


Inserting document link
From the update wiki editor view, select the find document  icon. A document finder popup will appear.


Select the document you want to link and click on the Add link button.
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Inserting folder link
From the update wiki editor view, select the find folder  icon. A folder finder popup will appear.


Select the folder you want to link and click on the Add link button.


Insert new wiki page link
From the update wiki editor view, select the new wiki page  icon. A popup will appear.


Set the new wiki page title ( if it already exists, it will not replace the existing wiki page ) and then click on the Add
button.
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Insert existing wiki page link
From the update wiki editor view, select the wiki page  icon. A wiki page finder popup will appear.


Select the wiki page, and then click on the Add link button.


General wiki
In Dashboard view, there's a general purpose wiki. The main wiki page - called index - cannot be deleted. This view
includes navigator buttons with history of wiki pages clicked by users.
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Zoho
The Zoho Suite is a Web-based online office suite containing word processing, spreadsheets, etc. OpenKM
integration make possible online editing of documents stored in OpenKM repository.
When you enable the Zoho Extension you will see a new entry in the Tools menu. This submenu has a couple of
entries to edit text documents and sheets.


Zoho Writer option will be avaible when you select a document of these types:
•• Microsoft Word (doc)
•• OpenOffice Text (odt)
•• Rich Text Format (rtf)
•• Plain Text (txt)
•• HTML (html)
Zoho Sheet is enable if you select a document of these types:
•• Microsoft Excel (xsl)
•• OpenOffice SpreadSheet (osd)
Once you have selected the document, click on the Zoho application and will open a dialog where you can modify
the document contents:
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Every time you click on the Save button, the document is sent back to OpenKM and a new version is created. Once
you have completed the edition, click on the Close button to close the dialog and continue using OpenKM.
In order to use Zoho Extension you need to provide the following parameters:
•• zoho.user
•• zoho.password
•• zoho.api.key
•• zoho.secret.key
You can obtain the user and password registering at http:/ / zapi. zoho. com. Once registered and logged, you can
request the API Key and the Secret Key. In the Zoho Dashboard you can also check how many edition request you
have performed.


Comunications between Google Docs and OpenKM uses always the secure https protocol.
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Google docs
Google Docs is a online, free word processing with Google documents, where can create and share documents on the
web and access them from any computer or smart phone. The familiar desktop feel makes collaborative editing easy.
When you enable the Google Docs Extension you will see a new entry in the Tools menu. This submenu has a
couple of entries to edit text documents, sheets, presentations, create new documents or import/export from Google
docs.


Google Docs option will be avaible when you select a document of these types:
• Edit: The supported formats are csv", "doc", "docx", "html", "htm", "ods", "odt", "pdf", "ppt", "pps", "rtf", "sxw",


"tsv", "tab", "txt", "xls", "xlsx"
• Create new file: The supported formats are "doc", "txt", "odt", "rtf", "xls", "ods", "csv", "pptx"
•• Import from Google Docs
•• Export to Google Docs
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Editor
Once you have selected the document, click on the Google docs menu option editor and will open a dialog where
you can modify the document contents:


Several users can edit the file at same time. If you click on editor button, you can add or remove google editors.
Note that only the user who started the edition is able to cancel checkout or checkin the document.


Editor are defined by gmail addresses, each time you add or revoke a editor grant Google Docs automatically sends a mail to the user.


If you click on cancel checkout button the document will be checkout in OpenKM repository and remote Google
docs will be deleted.
If you click on checkin button the document will be checkin in OpenKM repository and remote Google docs will be
deleted.
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Create new file
Click on Google Docs menu option create new file will open a dialog where you should indicate the document name
( without extension ) and the file type:


Click on button create and then will open a dialog where you can add document contents:


Finally click on button create, the document will be checkin to OpenKM repository and deleted from Google Docs.
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Import from Google Docs
Click on Google Docs menu option import file will open a dialog:


Type at least tree characters to doing some query - filter - in Google Docs. Select some document and then make
double click or select button import.


The selected document will be imported to OpenKM and converted to one of these available formats "doc", "txt", "odt", "pdf", "png",
"rtf", "html", "zip", "pptx", "swf", "xls", "ods", "csv", "tsv". If conversion is not possible will be imported in the same Google docs
mime-type.


Export to Google Docs
Select some file. Click on Google Docs menu option export file will open a dialog:


Click on button accept and the document will be created in the Google Docs account.


For security reasons any document created or edited from OpenKM using Google docs integration is definitive deleted from Google
Docs, after edition or creation. Each document created temporary in Google Docs has security restrictions to be only available to Google
Docs account owner.
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Comunications between Google Docs and OpenKM uses always the secure https protocol.


Document expiration
Document expiration is a notification system alert which can be used to advice users nearly document expiration and
expired documents. Notification messages can be configured by administration parameters.
Document expiration is based in metadata, crontab features and report features.


Properties
In configuration properties can be defined several parameters, for example, days to expiration alert or mail text
message.


Metadata
Document expiration has this metadata definition:


Document expiration metadata state has tree values:
•• Notification
•• Valid
•• Expired
Notification indicates document is pending send mail to users indicating new document with expiration dates. Valid
indicates the document is valid. Expired indicates the document has been expired.
Each state can have sevaral notification groups. Each notification group can has one or more users. Which user
groups configuration from administration can be defined any type of associations grouping users.
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Crontab
There are three crontab task:


• Crontab InitialNotificationation.jar task is used to send notification to user groups linked with notify select
multiple.


• Crontab AlertExpirationNotificationation.jar task is used to send notification to user groups linked with notify
nearly expiration select multiple.


• Crontab ExpirationNotificationation.jar task task is used to send notification to user groups linked with notify
expiration select multiple.


Reports
There are three reports, valid, pending to expiration and expired document reports.
Administration reports view


Front end reporting menus
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Macros
Macros allows users to simplify repetitive operations in one click. Operations are defined in configuration
parameters. When OpenKM detects macro is available in some folder, document or mail automatically the macro
button is enabled and user with one click executes the operation.
•  → Execute macro


Enable macros
See Community extension section how to enable macros in your OpenKM.


Properties
In macro.actions property can define the actions.
For example move any subfolder into origin folder to destination folder will be defined as
[origin_path,destiantion_path] as can see in next image. The
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Example
The images example covers move a document from /okm:root/origin to /okm:root/destination.
Property macro.actions value is /okm:root/origin,/okm:root/destination


The file /okm:root/origin/test/invoice-1023.odt is into folder /okm:root/origin and has fast action button enabled


After executing macro the file /okm:root/origin/test/invoice-1023.odt has been moved to
/okm:root/destination/test/invoice-1023.odt. In case folder /okm:root/destination/test not exists OpenKM will
create automatically with correct grants.


Live Edit
This extension make very easy to edit documents in OpenKM. Keep on mind that you need to activate the extension
in the user profile to see it in action.
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When this extension is enabled, the action of the "Checkout", "Checkin" and "Cancel checkout" toolbar buttons
change and will be used to edit the document in this new way.
Once the Checkout button is clicked, the document will be downloaded locally, opened with the default editor and
marked as checkout. Of course, if you want to edit a .doc document you need to have installed Microsoft Office or
OpenOffice / LibreOffice in your computer. Every time you save the document will be sent to OpenKM to preserve
the changes. But the OpenKM document won't be modified until you click on the Checkin toolbar button. This
dialog will be shown:


Where you can write a comment as the traditional edition checkin dialog.
If you close the local application editor (MS Word, MS Excel, OpenOffice, LibreOffice, etc.) and want to keep
modifiying the document, make double click in the desired document row at the Editor applet window.
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Merge files
To merge files, select several pdf files.


Then select Merge pdf menu option. Merge pdf can be found in filebrowser contextual menu or in Edit menu.


Will be shown the merge pdf poup.
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Add the new filename where will be merged pdf documents and click at merge button. When merge opertion will
be done will be shown new document with all document contents merged.


OpenMeetings
OpenKM is integrated with [OpenMeetings [1]]. [OpenMeetings [1]] is a free browser-based software that allows you
to set up instantly a conference in the Web. You can use your microphone or webcam, share documents on a white
board, share your screen or record meetings. It is available as hosted service or you download and install a package
on your server with no limitations in usage or users.
In dashboard there's a icon to access meetings:


Dasboard is divided in two sections, available rooms and form to create new rooms.
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Configuration
The configuration parameters are:
•• openmeetings.user ( openmeetings user )
•• openmeetings.credentials ( opemeeting password )
•• openmeetings.port ( openmeetings port, normally 5080 )
•• openmeetings.url ( openmeetings url )


Create new room
There're four room types:
•• Public conference
•• Private conference
•• Restricted
•• Interview
Each room can have aditionally name, appointment, moderated or not, allow recording or not, only audio room
among others parameters. Simply fill the creation form and click the add button.


After creation will be refreshed available user rooms:
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Invite users
Only in user room - created by user - is allowed invite users. Simply click on user icon  will appearing invitation
popup:


Select users / roles to notify, write some subject and click send button. User will receive some mail notification like
this:
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Enter room
Simply click on room link or mail invitation link, then you'll see new room tab like this:


Delete room
Simply click on delete icon  and room will be deleted.
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